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[bookmark: _Toc103867056]Introduction 
This guidance is for new users of Smart Survey - a standard survey, questionnaire and feedback tool. In this guide we cover:
Creating surveys
Adding and editing questions
Controlling responses
Distributing your survey
Viewing and analysing submitted feedback
If you have more specific questions or need advice on other features, please email digital@healthwatch.co.uk. Additionally, throughout this guidance there are links to further information from Smart Survey.
[bookmark: _Toc103867057]Accessing Smart Survey
If you have already contacted us to request an account, you will have received an invite from Smart Survey prompting you to finalise an account via your preferred email address. 
All local Healthwatch accounts are underneath the parent Healthwatch England account – so if you need assistance with your licence or access contact digital@healthwatch.co.uk.
If you forget your password, use your account email address to set it yourself via the ‘Forget your password’ link on the login page (we are unable to set passwords for you directly, and it is not secure for us to do so).

[bookmark: _Toc103867058]Creating surveys
[bookmark: _Toc103867059][image: ]Creating a survey from a template

Smart Survey comes with many survey and questionnaire templates. Using these can save you time when creating your own surveys.
Click on Use a Template.
The available templates are sorted by category, so choose the category you want.
Hover your mouse over each template in the list, you will have two buttons.
· Click the Preview button to see an interactive preview of the template.
· Click the green Use Template button to select the chosen template.
You can change your template selection by using the Survey: drop-down. If you want to return to the previous step, click Back to templates.
On choosing a template, you will be prompted to enter a Survey Title.
If you want the survey to exist in a particular folder, use the Select a folder drop-down to choose your desired folder.
Click the green Create Survey button.
[bookmark: _Toc103867060]Creating a survey from scratch
Click Create from scratch.
Type a descriptive Survey Title.
Under Language, the default language is English. To change the survey language, click on the drop-down menu. If your preferred language is not listed, please raise a support ticket to request the language you would like to use. Smart Survey supports all languages, it's just that those listed have built in templates with the core functionality already translated (such as the Next Page button, Submit, etc.). Our subscription allows you to customise all the text for the language used in your survey, including these elements.
If you want the survey to exist in a particular folder, use the Select a folder drop-down to choose your desired folder.
Click the green Create Survey button.
From here you can start adding questions to your survey.

[bookmark: _Toc103867061]Adding questions
Click the green ‘Add Question Here’ button within your survey to open the add question popup.
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In the ‘Question Type’ field, select the type of question you wish to create from the drop-down menu.
In the ‘Question Text’ field, type the question that you would like to ask.
The ‘Enable Editor’ button below the text box allows you to customise the font style and layout.
In the ‘Answer Options’ section fill in the relevant fields to complete the setup of your question.
Click the green ‘Add Question’ button. 
Unsure which question type you need? Instead of selecting a question type from the dropdown menu, click the blue button labelled ‘View Question Examples’ to see a visual representation of how the different questions can look. Also see our guidance on good survey practice. 
Using Pre-Made Answers
You can populate the answer field with pre-made answers to save time when creating a survey. Pre-made answers can be edited and customised once you have selected them.
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In the ‘Add Question’ pop-up window, after adding your question and selecting ‘Question Type’, scroll down to ‘Pre-made’ on the right of the ‘Answer Options’.
In the ‘Answer Template’s drop-down menu, select the pre-made answer list you want to use. Some of these answer templates allow for a variable number of points on the scale, so choose the level of granularity you want via the ‘Scale’ drop-down.
The field is populated with the pre-made answers that you have selected.
Use the buttons below the ‘Answer Choices’ box to reverse the order of the options or to sort them alphabetically. Note: Any order set in this way will be overridden by using the randomisation function in the question options.

You can still edit the answers if you require. Simply select the question you want to edit and click ‘Edit Question’ as described above.
Remember to click ‘Save Question’.
[bookmark: _Toc103867062]Question types
Smart Survey offers 17 different question types, each featuring different variations and customisation options. Some of these question types may appear to be similar to one another, but each offers different functionality, so it's worth investigating all of them before you start building your survey.
The table below briefly describes these question types. Click the link on any question type for more information and to see examples on how they might be used.
	Question Type
	Description

	Multiple Choice
- One Answer
	Provide a list of possible answers to a question. Only one answer can be selected. This question type can be used for single choice answers, rating and likert scales. You can display answer choices in a vertical or horizontal configuration, or as a drop-down menu.

	Multiple Choice
- Multiple Answers
	Provide a list of possible answers to a question. Multiple answers can be selected from a list. Answer choices are displayed as Checkboxes and they can be organised into 1, 2, 3 or 4 columns or otherwise in a single row.

	Comment or Essay Box
	Allow respondents to enter free text comments. Ideal for feedback and other long-form comments. This question type allows you to limit the number of characters and words that can be entered using validation.

	Ranking
	Add a list of choices for your respondents to then rank in order of their preference, using drag and drop or by selecting the ranking number from a drop-down box next to each option.

	Matrix of Choices
- One Answer Per Row
	Generate a table of radio buttons in rows and columns, allowing respondents to make a single choice per row. This question can be used as a rating scale but for numerous options.

	Matrix of Choices
- Multiple Answers Per Row
	Generate a table of radio buttons in rows and columns, allowing respondents to make multiple selections per row.

	Matrix of Text Boxes
	Generate a table with customisable column and row headings. For each row and column there is a text box within which respondents can type free text answers. This is sometimes referred to as a Matrix spreadsheet.

	Matrix of Drop
- Down Menus
	Generate a table with customisable column and row headings. For each row and column there is a drop-down menu from which respondents can make their answer choice.

	Single Textbox
	Add a single line text entry field. Designed for brief answers, for example: Please enter your name.

	Multiple Textboxes
	Add several text boxes within one question. Designed for several pieces of related information (such as contact information).

	Descriptive Text
	Place informative text or media into the survey without asking a question. Use this to add introduction text, instructions, embedding videos or images. Although this is a question type, respondents cannot input anything.

	Date/ Time Box
	Generate a date or time entry field. Designed to collect dates or times in a standardised format. 

	Net Promoter® Score
	Generate a ranking scale from 0 to 10. 

	Continuous Sum
	Generate a series of textboxes that accept numbers only. As the respondent enters numbers into the fields, the total sum of each entry is automatically calculated and displayed below.

	Slider Scale
	Generate a slider that can be dragged left or right to select a numeric value. This question type can be used to capture a value, percentage, or the degree of agreement to a statement.

	Semantic Differential
	Provide two options either end of the scale. The respondent can then select the radio button in the position that most closely represents their feelings towards both options. This question type is typically used to present two opposite views, and measure how strongly the respondent agrees with one or the other, on either end of the scale.

	File Upload
	Generate a simple file upload button which allows the respondent to attach a file in response to the question. This can be used for capturing a multitude of file types, including photos, text documents, and scanned files.


[bookmark: _Toc103867063]Question settings
Making responses mandatory
You can force users to provide an answer to a question. This avoids a situation where the respondent can submit a blank response or skip the question. The only exception to this would be if you use Skip Logic within your survey and the rule you set as part of that means a respondent "Skips" the page that this question is contained upon.
[image: ]Healthwatch England recommends not making questions mandatory as they act as a disincentive to people completing a survey, except where the question is a filter (i.e. to filter people out of the survey or to a different set of questions).
 
Adding an ‘Other’ or ‘Comment’ field
If you are adding a multiple-choice question where the answer choices you provide are not exhaustive, then having an ‘Other’ field is useful. It means you can list the most common options but ensures that respondents have the option to provide their own answer.
For questions where an answer choice could require a further explanation, or where you'd like the respondent to explain their answer choice you may want to give the respondents the freedom to add their own comments with the ‘Comment’ field.
To add an ‘Other’ choice:
Click ‘Add Question’ to add a new question or click ‘Edit Question’ to customise an existing question.
In the ‘Answer Choices’ section, click the ‘Add Other’ choice field checkbox.
Set the label, size and character limit for the answer.
Optionally, check ‘Require an answer’ if you want to make the response mandatory.
To add a Comment field:
Click ‘Add Question’ to add a new question or click ‘Edit Question’ to customise an existing question.
In the ‘Answer Choices’ section, click the ‘Add Comment’ field checkbox
Set the label and size for the answer.
Optionally, check ‘Require an answer’ for this to make the response mandatory.
[bookmark: _Toc103867064]Managing pages
Adding pages to your survey helps organise and structure the questions so your respondents don’t have to load them all at the same time. Pages are also critical if you are going to be using skip logic/branching (see below).
[image: add new survey page]Adding a New Page

Go to the Design section of your survey:
Look for the ‘Insert Page Here’ button in your survey. The button appears above or below existing pages. You can also split page by clicking the ‘Split Page Here’ button in-between questions.
Click the ‘Insert Page Here’ button where you want the new page to appear.
Add a ‘Page Title’ and ‘Page Description’ or leave blank.
Click the green ‘Save Page’ button.
The page title that you enter on this screen will appear in other parts of the survey design screen. In particular, the title appears when you are building skip logic. We recommend that you use a related page title to make it easier to refer to the page later, should you need it (avoid ‘page 1’, ‘page 2’ etc).
[image: manage survey pages]You can also Edit, Copy, Move and Delete pages giving you full control of managing your survey.

If you wish to move pages around in Design view of your survey:
Locate the horizontal ‘Page Options’ menu on the page you want to move and click the ‘Move’ button. Alternatively, you can click on the ‘Organise’ button in the white navigation bar.
Drag and drop your page into its new position.
If you cannot see all of your pages on one screen, click the grey ‘Hide Questions’ button to make the page more compact.
Repeat the above two steps for all of the pages you want to move.
[image: ]Click the green ‘Save Changes’ button.


[bookmark: _Applying_skip_logic][bookmark: _Toc103867065]Applying skip logic or branching
Skip Logic (also referred to as 'branching') allows you to take your respondents through a certain path, depending on the answer they give to a previous question.
For example, you might want to ask the respondent if they had difficulties getting a COVID-19 vaccine. If the respondent answered ‘yes’ you would present them with a further question in order to determine what those difficulties were. If they answered ‘No’ you would want the experience to ‘jump’ over that question.
Before you begin, you must construct your survey so that it has more than one page. Skip logic cannot filter questions within the same page.
[bookmark: _Toc97737424][bookmark: _Toc103867066]Adding basic Skip Logic
[bookmark: _Toc97737425]On the Design page of your survey, next to the first question where logic needs to be applied, click Skip Logic.
[bookmark: _Toc97737426][bookmark: _Toc97737427]Click ‘Add New Rule’.
Select the ‘Condition and Choice’ to determine the criteria for the rule to be applied:
· The Condition is the action that triggers the logic 
· [bookmark: _Toc97737428]The Choice creates a rule that will fire when the selected answer matches the selection in the Choice drop-down menu
Select the Action and Page to determine how the survey will behave once this rule runs
· The Action determines what will happen
· [bookmark: _Toc97737429]The Page is the destination that the respondent will be sent to
[bookmark: _Toc97737430]Repeat steps 3 and 4 to add a rule for each question you want to apply skip logic to. Select Skip Over Page to choose the question that will be omitted
Click Save to apply skip logic to your question
A typical application of logic might look something like this: 
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But you can also use skip logic if you need to disqualify a particular user (ie. ending their survey early). Find out more about skip logic. 
[bookmark: _Toc103867067]Formatting surveys
Formatting surveys are controlled by Smart Survey’s themes. We have already created a ‘Healthwatch’ theme for you to use that features our brand colours and font. To apply the theme to your surveys, click the ‘Theme’ button on any survey edit page:
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Choose the ‘HWE1’ theme and your live survey will immediately update. Please note this doesn’t change how the survey looks in edit mode – only in ‘preview’ or ‘live’ mode (i.e. as a user would see a final survey).
[bookmark: _Toc103867068]Sending surveys and collecting responses
Smart Survey offers several different ways of collecting responses to your survey, offering you flexibility in deciding the best way to reach your target audience.
There are eight methods to choose from. However, unless you have a specific user journey in mind, we recommend that you always try to embed a survey into your website as a first option. This is because it looks better for the user, provides you with greater insight (your page views in Google Analytics), and also encourages the user to further interact with the site and your content after they have completed the survey. 
	Method
	Description

	Web embed
	Provides the functionality for you to embed the survey on your own website. In general, this is our preferred approach, for user experience and tracking reasons.

	Web link
	Provides you with a survey link you can share with your respondents. Anyone who is provided with this link will be able to access and respond to the survey. You can customise your web link.

	Email tool
	Allows you to create an ‘Address Book’ and distribute the survey via email through Smart Survey.

	Offline mode
	Allows surveys to be completed on an offline device. An offline survey link is created and responses are stored on the device ready for you to upload once you're back online.

	Buy responses
	Allows you to target a specific audience by purchasing a consumer panel.

	Facebook
	Promote your survey by posting a link directly to Facebook.

	QR code
	Generates a QR code allowing recipients to scan the code and access the survey on a mobile device.

	Popup Invite
	Delivers a survey invitation as a pop-up window during, or after, a respondent's visit to a website.



[bookmark: _Toc103867069]Before you send (tracking links)
One built-in useful feature of Smart Survey is the ability to generate various ‘versions’ of the links you use in order to promote your survey. This is useful because you can segment submissions based upon the channel used to promote your survey. For example, you may create a tracking link just for social media, one for email, and one for your website. 

By doing this, Smart Survey, will be able to provide you with the analytics showing which channel has been most popular in terms of response rate.  It also helps survey administrator keep things nice and tidy. 
Setting up Tracking Links:
Go to the ‘Collect’ page of your survey.
Ensure that your surveys ‘Global Status’ is set to ‘Open’.
Scroll down to the horizontal menu under ‘How do you want to collect responses?’
Select a collection method.
You can set up as many collection methods as you want for each survey. Each collection method creates a unique link listed under Tracking Links in the Collect tab for each survey. To customise tracking links:
Go to the Collect page of your survey.
Click on the Tracking Link Name of the collection method you wish to customise
In the Link tab, click the orange Customise Link button to edit the text of the web link.
Use the Link Settings and Toggle Advanced Settings tabs to customise the security, restrictions, cut off details, language, themes and notification options.
[bookmark: _Toc103867070]Embedding surveys on your Healthwatch website
Embedding a survey on your website is a two-step process: you first generate and copy the embed code, then you add this code to a page of your choice on your own website. 
[image: ]First, in ‘Collect’ view click the web embed option of your survey of choice









[image: ]You can create several versions of a ‘web embed’ instance, but for now it’s particular worth noting that for anything other than very short surveys/forms, you should amend the ‘height’ value so that vertical scroll-bars don’t appear on your final page 
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Choose the ‘my embed code is not working’ and Copy the generated code in the textbox to the clipboard. It will look something like: 



If you use the Healthwatch website template, you can embed your survey by going into ‘edit’ mode for the page you wish the survey to appear on. You can either directly the Smart Survey embed code to an existing text area, or a new text area. If you wish it to sit in a new one, create a new ‘Text’ paragraph type. Ensure the chosen text area is in ‘Source’ mode and simply paste in your copied embed code.
If you want a hand with this, please do drop digital@healthwatch.co.uk an email and we’ll be happy to help you get your surveys on your website.
[bookmark: _Toc103867071]Email notifications
Notifications of surveys completions can easily be configured to enable you to keep track of a live survey via your inbox. Smart Survey comes with a basic level of Response Notifications in addition to a more comprehensive Email triggers. 
[bookmark: _Toc103867072]Basic Notifications
To turn on notifications:
Go to the ‘Collect’ page of your survey.
Click on the ‘Tracking Link Name’ of the tracking link you wish to modify (you can configure to only be alerted to certain tracking links if you have several set up).
In the pop-up box, select ‘Link Settings’.
Check the box next to ‘Email Notification’.
Type the email address you would like notifications to be sent to. Remember to ‘Save Changes’.
[image: ]

[bookmark: _Toc103867073]Email Triggers
This functionality allows you to configure more complex triggers for your surveys.
To create an email trigger:
1. Go to the Survey Design page of your survey. In the white navigation bar at the top of the screen, hover your mouse pointer over Options

[image: ]

From the drop-down menu, click ‘Email Triggers’.
Click the green ‘Add Email Trigger’ button then select ‘Create From Scratch’ from the drop-down menu.
Fill in the details for ‘Sender Email Address’ and ‘To Email’. Use a semicolon to separate email addresses if you want to send the email to multiple recipients.
Add the email content in ‘Body’. Optionally, check ‘Include survey response as PDF attachment’ to send the recipient a copy of the survey answers.
Click the green ‘Save Email Trigger’ button.
Using Piping in Email Triggers
You can use piping to import information into the ‘To Email’, ‘Subject’ and ‘Body’ fields of an email trigger. For example, you could automatically populate the ‘To Email’ field with the respondent’s email address that they entered when completing the survey.
Information can be piped from your contact list, your survey answers, and survey variables (including custom variables). Under any field click ‘Insert Piping’ and select the variable you want to use from the drop-down menu.
Here the values in the square brackets indicate piped values (ie. Variables). 
[image: ]
Following on from the example above, to use an email address as a custom variable for your survey in a triggered email:
Under ‘To Email’, choose Email Address from the drop-down menu.
Click ‘Insert’ [contact(email)] will appear in the ‘To Email’ box.      
More information on configuring Conditional Email Triggers.
[bookmark: _Toc103867074]Analysing your results
If you do a significant amount of data analysis, we recommend you refer to the Elearning course specifically catered for Analysing Survey Results in Smart Survey. This has been put together by the Healthwatch England Research Team to help you draw insights from your survey data.
[bookmark: _Toc103867075]The Results Summary
The Results Summary Report shows the top-line results of your survey at a glance, so you can quickly and easily see how your respondents have answered. To view the ‘Summary Report’, simply click the ‘Results’ tab in the blue navigation bar. The ‘Summary Report’ will be the first page that comes up.
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Using the Results Summary
The summary page is divided into Four main areas below the white nav bar.
View Management Bar: This is a bar below the main nav and is used for managing Views.
Overview / Control Panel: This is a box on the left and both shows overview information about the survey and also to control Filters, Display Options, and View Sharing Links.
Display Status Area: This is a small area that shows extra information about what is currently being displayed.
The Main Results area: This is where the results for the survey are displayed in numerical and visual format.
View Management
The ‘View Management’ bar is where you can switch between your defined views by using the drop-down and save views for future use. Use of this feature is restricted by account level and you may see less or more in your area dependant on your access controls. 
Overview Tab
This area performs two functions. when the page first loads, or with "Overview" clicked, this is where you can see the top-line statistics about the survey:
Total: The number of people who have started the survey, whether they completed it or not.
Partial: The total number of partial responses received so far.
Completed: The total number of completed responses received (where the user has clicked to complete the final page of the survey).
Other information in this box
Below the top-line stats you can see the date and time the most recent response was collected, and a link to view the partial responses for the survey.
Filter Tab
This tab allows you to choose a pre-defined filter to apply to the summary report. Choose a filter form the drop-down and click the ‘Apply Filter’ button to apply the filter.
If you want to create a new filer, click the ‘+’ Icon in the upper-right of the box, above the drop-down.
Display Options Tab
This tab allows further customisation of how the Summary Report looks. It has two sub-tabs.
Summary Display Options:
This tab is where you can set display options for the summary report, including or excluding particular elements of the report.
[image: ]   [image: ]   
This section has a lot of options so is dealt with on its own page. See guide for Summary Display Options.
Extra Information
The first two allow you to show extra information:
Show Basic Statistics: Activates a set of statistical measures calculated for each question. For more information, see “What are Basic Statistics?”.
Show Matrix Charts: Because charts based on matrix questions can sometimes take up a lot of space, they are disabled by default. This toggle will activate them.
Survey Structure
The next three are used to show or hide Survey structure information:
Hide Page Titles: Don’t show the page titles.
Hide Page Numbers: Don’t show the survey page numbers.
Hide Question Numbers: Don’t show the survey question numbers – these are the numbers as seen in the survey editor and won’t affect any survey numbers that have been added as part of question text.
Data and Privacy
The next three are related to respondent data and privacy:
Hide Open-Ended Text: Don’t show any text that the respondent can freely enter. This covers both specific question types for this and comment or other boxes on multiple choice questions.
Hide Response IDs: If Open-Ended Text is NOT hidden, then the response ID data will be removed from the listing of the text responses.
Hide Response Dates: If Open-Ended Text is NOT hidden, then the response date and time data will be removed from the listing of the text responses.
Printing
The last option only affects the print–friendly version of the report:
Include Page Breaks: If this is activated, the print version of the report will include page breaks at the same point as any included in the survey.
Hide / Show Questions
This tab controls whether particular questions are included or excluded in the summary report. There is a detailed guide to using this feature on the Smart Survey site: guide to hiding and showing questions in a Summary Report.
[bookmark: _Toc103867076]Managing Views
The Views feature allows you to create and save pre-defined views for the Survey Summary Page.
By doing this, you can save time switching between your commonly-used filters and other display preferences.
Choosing a View
When the Results summary loads, you’ll see a new bar under the white navigation. In this new bar, you’ll see a drop-down box marked as ‘View’: with ‘Original View’ selected in the drop-down. 
This drop-down is where your created views can be selected. You can also create a new view by clicking the ‘Create New View’ option as part of the drop-down.
Creating a New View
Changing Chart Settings
You can change how charts are displayed in the Summary Report by Clicking ‘Customise’ above any chart in the report. For any details on how to use the chart settings, see Creating Charts From Survey Results.
Other View Settings
To the left of the Survey results, There is an area headed’Overview’. On page load, this shows overall data about responses – the number of complete, partial, and total responses, plus the time of most recent response. There’s also a link to view the partial responses.
Below ‘Overview’ you can see two other expanding sections, ‘Filter’ and ‘Display Options’.
[bookmark: _Toc103867077]Applying a Filter
On clicking filter, you will see one of two things:
If you have not created any filters, you will see a link to take you to the filter editor to create one.
If you have already created filters for this survey, you will see a drop-down with them listed. Choose your desired filter from the list and click ‘Apply Filter’ to select it.
In addition, if you have an appropriate-level account, you can directly apply a date filter to the summary.
Display Options
The second expander, ‘Display options’, opens two further expanders - Summary Display Options and Hide / Show Questions.
Summary Display Options:
Contains a number of toggles where you can activate or de-activate a variety of features on the summary report.
For Detailed help with this feature, visit this page on the Smart Survey site: Summary Display Options.
Hide / Show Questions:
This lets you choose what is and isn't included in the view down to the question level. for detailed help, see the help here: Hiding and Showing questions in the result Summary.
[bookmark: _Toc103867078]Share
This expander is for creating sharing links for your selected view with others. These are referred to as Shares and more information can be found below.  
Saving or Discarding the View
If you make any changes to these settings, a green ‘Save As’ button will appear in the upper-right, in the same bar as the ‘View’ drop-down.
Click this to save the view and give it a name.  The view will now be listed in the ‘View’ drop-down.
If instead, you wish to discard the changes, you can do this by clicking the ‘Down-arrow’ next to the ‘Save as’ button.
Managing Existing Views
If you have at least one saved view, when you expand the ‘View’ drop-down you will see them listed with the original view.
Alongside each view, you will see an ‘options’ icon (three dots “…”). Clicking this will open four options:
Set as Default: make this view apply automatically when the summary page loads.
Duplicate View: make a copy of the view with the same settings.
Rename View: Give the view a new name.
Delete View: Remove the view from your list.
There is also an ID number for the view in this menu which you may be asked for when seeking support for a view.
Editing and Saving and existing view
If you make changes to an existing view with it applied to the page, you will see the ‘Save’ button in the upper-right. Clicking this will save your changes over the selected view. If you wish to revert to the saved state, click the ‘down’ arrow next to the button and choose ‘discard changes’.
[bookmark: _Toc103867079]Sharing Survey results
This is where you can create sharing links so that people you wish to view the report can do so without needing a Smart Survey Account. 
Please note:  due to our obligations under GDPR, please consider whether you need to share data before you do so. Obtain advice from your local data protection advisor if you are unsure.
It’s possible to create a share link for any view that you’ve applied to the summary report.
When the link is opened. The report will open with all the settings of the view applied – Display Options, Filters, and Question Hide / Show settings. These will not be editable by the viewer, allowing you to share only those survey elements you want to, and not display anything you do not wish to display.
A password can also be applied for additional security.
Creating a Shared View Link
First, select the ‘View’ you wish to share. For help on creating and saving views, see above content on ‘Views’.
From the menu on the left of the page, click the ‘Share’ option. This will open an expander. Click ‘Create New Share’ to create your link. A pop-up will open.
Configuring the new Share
Complete the pop-up box to complete the setup of your new Share.
The options are:
Access: This can be ‘Anyone with the link’, or ‘Password protected’. Click on your desired option. If ‘Password Protected’ is chosen, an additional box will appear where you can define the password.
Page Title: This is the title of the page that will be shown to visitors viewing the Share. If left blank, the survey title is used.
Description: This is an optional area where you can add a brief description of the Shared report, for viewers.
Include Survey Response Stats: Check this to include the details of the ‘Total, Completed’, and ‘Partial responses’ collected by the survey. These values will be affected by any applied filters.
After you’ve finished configuring the share, click ‘Create Sharing Link’.
You will now see a bar at the top of the pop-up with the shareable link in it. Next to the shareable link are options to copy the link to the clipboard or to visit the link directly.
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Another option will now be visible, ‘Sharing Link Status’. This is a toggle to enable or disable the share. If you need to stop access to the share, but not remove it entirely, set this to ‘Disabled’. 
When you are happy with the ‘Share’, click ‘Finish’.
Display Status Area
This is the area above the main results display and shows some extra information about what is being displayed. From the left, there is information on the number responses being displayed and the effect of any applied filters. Next is a drop-down do allow the main display area to be focused onto a specific survey page. 
Finally, there are two buttons:
Down Chevrons: load all page content in one go instead of dynamic loading as the page is scrolled. This can be beneficial if you intend to scroll straight to the bottom.
Options: From here you can access the ‘Send to Word’ and ‘Print Friendly’ features.
Main Results Area
This is the largest part of the page and is where you'll see the results of your survey displayed.
The contents of this area can be affected by the settings chosen in Display Settings, so this guide will explain them in the default configuration.
Every question has its results displayed in its own box. All the boxes have a dark grey bar at the top with the question text, and a light grey bar at the bottom showing the number of the respondents who answered the question or skipped it (either by Skip Logic or simply not answering it.).
For multiple-choice style questions, each option will be shown along with the total number or respondents choosing it, that number expressed as a percentage of the total, and a data bar visualiser.
To create your own chart of the data, click the ‘Create Chart’ button in the upper right of the box, in the grey bar where the question text is shown.
‘Other’ or ‘Comment’ response information can be seen via an expander below the set options.
For Open-ended or Free Text style questions, a list of all the responses is shown. this can be hidden using the "hide" button. Text Analysis is available via the link in the upper-right of the box.
See also: How to analyse qualitative data.
[bookmark: _Toc103867080]Sharing surveys with other Healthwatch
By default, each survey created in one account is specific to that account. However, our Healthwatch environment enables each Healthwatch the ability to share surveys with other Healthwatch, should they wish. 
You can choose to simply ‘push’ surveys to enable - for example - other Healthwatch’s in your ICS group to use your ‘master’ copy of a survey. Or you can enable true collaboration and provision partner accounts with editing abilities, if required.
To make available your survey to another Healthwatch: 

[image: ]When in edit mode of the survey you wish to share, go to ‘Options > Permissions’.









In the Permissions pop-up select the account(s) on the left you wish to share the survey with, and choose their permission levels on the right: 



[image: ]















Be sure to click ‘Apply changes’.
Now, when that Healthwatch log into their account, they will see a ‘Shared with me’ section, containing the surveys that have been shared with them: 

[image: ]



[bookmark: _Toc103867081]

Further help & resources
For general queries about survey design 
For guidance on Data Protection issues
How to analyse qualitative data
How to record demographic information and why it’s important


Smart Survey  
1
Healthwatch England 
National Customer Service Centre
Citygate
Gallowgate
Newcastle upon Tyne
NE1 4PA

www.healthwatch.co.uk [image: ][image: ]
t: 03000 683 000
e: enquiries@healthwatch.co.uk
[image: P1038 HWE Local Healthwatch AR templates_v7 For Peter_1.jpg] @HealthwatchE
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